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EveryWare License Agreement

Tango Enterprise
IMPORTANT–READ CAREFULLY: This EveryWare Development 
Inc., End-User License Agreement (“EULA”) is a legal agreement 
between you (the person or organization that receives the software 
product identified above, which includes computer software and 
associated media and printed materials, and may include “online” 
or electronic documentation) and EveryWare Development Inc. By 
installing the software, you agree to be bound by the terms of this 
EULA.

Software Product License
1. DEFINITIONS
This section explains how certain terms are used within this License 
Agreement:
“You” and “Your” refer to the individual or organization that 
acquires or uses the software.
“EDI” refers to EveryWare Development Inc.
“The Software” refers to the software program listed above.
2. WHAT ARE YOU BUYING
A. Your are receiving a non-exclusive license to use The Software 
and any substitutions or renewals subject to the conditions and 
restrictions set out in Section III which follows. EDI retains title to 
The Software and all copies.
B. Specifically, in return for payment of a one-time license fee for 
The Software distributed with this License Agreement, you are 
authorized by EDI to use The Software and any substitutions and 
renewals EDI elects to provide only under the conditions specified 
in this License Agreement. Your authorization (also known as a 
“license”) is non-exclusive in that EDI is licensing others to use this 
software. You are receiving only a license to use this Software. EDI 
remains the owner of The Software, including the copies provided 
with this License Agreement or authorized to be made under this 
License Agreement.
3. USE OF THE PROGRAM/RESTRICTIONS
NOTICE: THIS PROGRAM IS PROPRIETARY TO EDI AND 
CONTAINS CONFIDENTIAL TRADE SECRETS OF EDI. IT IS 
FULLY PROTECTED BY THE COPYRIGHT LAWS OF CANADA 
AND OTHER COUNTRIES. ANY DUPLICATION OR USE OF 
THE PROGRAM WITHOUT THE AUTHORIZATION OF EDI, IS 
A VIOLATION OF THIS LICENSE AGREEMENT AND 
APPLICABLE LAWS.
You are authorized to use The Software accompanying this License 
Agreement only under the following terms and conditions:
1. The Software may be used on only one CPU at a time.
2. The Software may not be duplicated or copied except as 
necessary for archival purposes, software error validation, or to 
developers creating documents for use with the Software covered. 
As a condition of your authorization to make copies of The 
Software for these limited purposes, all copies must include the 
copyright notice as it appears on the original copy. The notice 
should be in the following form: “©EveryWare Development Inc. 
All rights reserved.” 
3. In no event shall The Software be altered, modified, adapted, 
translated, decompiled, disassembled or used in any form to create 
new software based on or derived from The Software or otherwise 
used to discover the source code for The Software. Such activities 
are prohibited under this License Agreement.
4. Except as necessary for distribution to legitimate users of The 
Software:

(a) You may not make copies of the manuals accompanying The 
EveryWare Software in whole or in part except as expressly 
provided in this License Agreement,

(b) You may not sublicense, lease, rent or grant other rights in all 
or any portion of The Software or any copies to others, except as 
expressly provided in this License Agreement. Any attempt to 
grant such rights is void.

(c) You may not make verbal or media translation of the manuals 
accompanying this Software.

(d) You may not make telecommunications data transmission of 
The Software.
6. This License Agreement will remain in effect until it is 
terminated. In the event that you fail to comply with any of the 
terms and conditions of this License Agreement, the License 
Agreement will terminate automatically without notice to you from 
EDI. If this license is terminated for any reason, you agree to 
destroy all copies of The Software (including all documentation) or 
return them to EDI.
4. UPGRADES
If The Software is labeled as an upgrade, you must be properly 
licensed to use a product identified by EDI as being eligible for the 
upgrade in order to use The Software. The Software labeled as an 
upgrade replaces and/or supplements the product that formed the 
basis for your eligibility for the upgrade. You may use the resulting 
upgraded product only in accordance with the terms of this EULA. 
5. DISCLAIMER OF WARRANTY AND LIMITED WARRANTY 
ON MEDIA
EDI will replace defective distribution media manuals at no charge, 
provided you return the item to be replaced with proof of purchase 
to EDI during the 90-day period after purchase. ALL IMPLIED 
WARRANTIES ON THE MEDIA AND MANUALS, INCLUDING 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO 
NINETY (90) DAYS FROM THE DATE OF THE ORIGINAL 
RETAIL PURCHASE OF THIS PRODUCT.
EVERYWARE MAKES NO WARRANTY OR REPRESENTATION, 
EITHER EXPRESS OR IMPLIED, WITH THE PRODUCT ITS 
QUALITY, PERFORMANCE, MERCHANTABILITY, OR FITNESS 
FOR A PARTICULAR PURPOSE. AS A RESULT, THE PRODUCT 
IS LICENSED “AS IS” AND YOU THE PURCHASER ARE 
ASSUMING THE ENTIRE RISK AS TO ITS QUALITY AND 
PERFORMANCE.
IN NO EVENT WILL EDI BE LIABLE FOR DIRECT, INDIRECT, 
SPECIAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM 
ANY DEFECT IN THE PRODUCT OR ITS DOCUMENTATION, 
even if advised of the possibility of such damages. In particular, 
EDI shall have no liability for any programs or data processed 
using the product, including the cost of recovering such programs 
or data.
THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE 
EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR 
WRITTEN, EXPRESS OR IMPLIED. No EDI dealer, agent, or 
employee is authorized to make modification, extension, or 
addition to this warranty. Some states do not allow exclusion or 
limitation of implied warranties or liability for incidental or 
consequential damages, so the above limitation or exclusion may 
not apply to you. This warranty gives you specific legal rights, and 
you may also have other rights, which vary from jurisdiction to 
jurisdiction.
6. GENERAL PROVISIONS
The terms of this License Agreement are intended to be severable. 
In the event that any part or provision of the License Agreement is 
held to be void or otherwise unenforceable, the remaining parts 
and provisions shall not be affected.
The laws of the Province of Ontario will govern this License.

Microsoft Software Disclaimer
NO OTHER WARRANTIES, TO THE MAXIMUM EXTENT 
PERMITTED BY APPLICABLE LAW, MICROSOFT AND ITS 
SUPPLIERS DISCLAIM ALL OTHER WARRANTIES, EITHER 
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE, WITH REGARD TO THE 
SOFTWARE PRODUCT, AND ANY ACCOMPANYING 
HARDWARE. THIS LIMITED WARRANTY GIVES YOU SPECIFIC 



LEGAL RIGHTS. YOU MAY HAVE OTHERS, WHICH VARY 
FROM STATE/JURISDICTION TO STATE/JURISDICITION.
NO LIABILITY FOR CONSEQUENTIAL DAMAGES, TO THE 
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO 
EVENT SHALL MICROSOFT OR ITS SUPPLIERS BE LIABLE FOR 
ANY SPECIAL, INCIDENTAL, INDIRECT, OR 
CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, 
WIHTOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS 
PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING 
OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE 
PRODUCT, EVEN IF MICROSOFT HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES 
AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT 
APPLY TO YOU.

Apple Software Disclaimer
APPLE COMPUTER, INC. (“APPLE”) MAKES NO 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT 
LIMITATIONS THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A SPECIFIC PURPOSE, 
REGARDING THE APPLE SOFTWARE. APPLE DOES NOT 
WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE OR THE RESULTS OF THE USE OF THE 
APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, CURRENTNESS OR OTHERWISE. 
THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE 
OF THE APPLE SOFTWARE IS ASSUMED BY YOU. THE 
EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED 
BY SOME STATES. THE ABOVE EXLUSION MAY NOT APPLY 
TO YOU.
IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, 
EMPLOYEES OR AGENTS BE LIABLE TO YOU FOR ANY 
CONSEQUENTIAL, INCIDENTAL OR INDIRECT DAMAGES 
(INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, 
BUSINESS INTERRUPTIONS, LOSS OF BUSINESS 
INFORMATION, AND THE LIKE) ARISING OUT OF THE USE 
OR INABILITY TO USE THE APPLE SOFTWARE EVEN IF APPLE 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMJAGES. BECAUSE SOME STATES DO NOT ALLOW THE 
EXLUSION OR LIMITATION OF LIABILITY FOR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE 
LIMITATIONS MAY NOT APPLY TO YOU. Apple’s liability to you 
for actual damages from any cause whatsoever, and regardless of 
the form of the action (whether in contract, tort [including 
negligence], product liability or otherwise), will be limited to $50.

Copyright Notices
The Tango manual, program design, and design concepts are 
copyrighted, with all rights being subject to the limitations and 
restrictions imposed by the copyright laws of the United States of 
America and Canada. Under the copyright laws, this manual may 
not be copied, in whole or part, including translation to another 
language or format, without the express written consent of 
EveryWare Development Inc.
Copyright © 1998 EveryWare Development Inc. All rights reserved.
Tango, Tango Enterprise, Tango for FileMaker, the Tango software, 
Tango Editor, Tango Server, Tango CGI, the documentation, and 
associated materials are © 1992–1998 EveryWare Development Inc. 
All rights reserved. Tango is a trademark of EveryWare 
Development Inc.
FileMaker is a registered trademark and the FileMaker Pro design 
is a trademark of Claris Corporation.

All other trademarks mentioned are the property of their respective 
owners.
JavaScript 1.2 Compatible. Portions © Netscape Communications 
Corporation 1996, All Rights Reserved.
THE LICENSED ELEMENTS ARE LICENSED “AS IS” WITHOUT 
WARRANTY OF ANY KIND, INCLUDING WITHOUT 
LIMITATION, PERFORMANCE, MERCHANTABILITY, FITNESS 
FOR ANY PARTICULAR PURPOSE OR NON-INFRINGEMENT. 
THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE 
OF THE SOFTWARE IS ASSUMED BY LICENSEE. SHOULD THE 
SOFTWARE PROVE DEFECTIVE, LICENSEE ASSUME THE 
ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR 
CORRECTION.
UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL 
THEORY SHALL NETSCAPE OR ITS SUPPLIERS BE LIABLE TO 
LICENSEE OR ANY OTHER PERSON FOR ANY INDIRECT, 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF 
ANY CHARACTER INCLUDING WITHOUT LIMITATION ANY 
COMMERCIAL DAMAGES OR LOSSES, EVEN IF NETSCAPE 
HAS BEEN INFORMED OF THE POSSIBILITY OF SUCH 
DAMAGES.
Calendar Conversion Code. Copyright 1993–1995, Scott E. Lee, all 
rights reserved.
Permission granted to use, copy, modify, distribute and sell so long 
as the above copyright and this permission statement are retained 
in all copies. THERE IS NO WARRANTY – USE AT YOUR OWN 
RISK.
Regex. Copyright © 1992 Henry Spencer. 
Copyright © 1992, 1993
The Regents of the University of California. All rights reserved.
This code is derived from software contributed to Berkeley by 
Henry Spencer of the University of Toronto.
Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions 
are met:
1. Redistributions of source code must retain the above copyright 
notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above 
copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided 
with the distribution.
3. All advertising materials mentioning features or use of this 
software must display the following acknowledgment:
This product includes software developed by the University of 
California, Berkeley and its contributors.
4. Neither the name of the University nor the names of its 
contributors may be used to endorse or promote products derived 
from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE REGENTS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 
NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, 
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.
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About This Guide
About This Guide

Tango™ Enterprise is comprised of two distinct components:

■ Tango Development Studio is used to develop and maintain your 
Tango applications. Tango Development Studio includes Tango 
Editor and Tango Personal Server.

■ Tango Application Server is used to deploy the applications 
created with Tango Development Studio.

Typical installations include a Tango Development Studio for each 
developer and one or more Tango Application Servers, depending 
on the volume of application users.

Note Tango Personal Server and Tango Application Server are 
referred to generally as Tango Server, unless otherwise 
specifically stated.

The Getting Started Guide gives you the information you need to 
install and start to use Tango Development Studio and Tango 
Application Server.

The topics covered in this guide include:

■ preparing to install Tango
■ installing Tango Development Studio and Tango Application 

Server
■ registering your products
■ starting and stopping a Tango Server
■ converting query documents from previous versions of Tango 

to application files
■ executing Tango application files
■ getting help.
1 1



Getting Ready to Install Tango
Getting Ready to Install Tango 

This section provides a checklist of things to review before you 
install Tango. Using this checklist helps ensure your installation 
goes smoothly so you are up and running as soon as possible.

Before you begin installing Tango, you should read in this section 
about:

■ checking your Tango package for completeness
■ what you need to know before installing Tango.

Checking Your 
Tango Package

Depending on which Tango product you have purchased, your 
package may contain either of the following:

■ Tango Development Studio includes a CD-ROM, Getting 
Started Guide, User’s Guide, Tutorials manual, Meta Tags and 
Configuration Variables manual, and Quick Reference card.

■ Tango Application Server includes a CD-ROM, Getting Started 
Guide, and User’s Guide.

CD-ROM

The Tango CD-ROM contains the installer program and, depending 
on which Tango product you have purchased, it may contain the 
following compressed directories and files:

■ Tango Server and Java Server files
■ Tango Editor
■ Tango CGI (Tango3.acgi or Tango3_68k.acgi)
■ Tango Server plug-in (Tango3 Server)
■ various folders to contain Tango program files, tutorials, 

demos, and samples
■ ODBC
■ user’s documentation in Adobe Acrobat format (.pdf) and 

Adobe Acrobat Reader software
■ program HTML help files
■ Read Me file.
22



Getting Ready to Install Tango
Tango Documentation

User’s documentation (except on-line HTML help) is available in 
printed form and, except for the Quick Reference card, in Adobe 
Acrobat (.pdf) format on the CD-ROM.

■ Getting Started Guide

■ User’s Guide

■ Tutorials (in Tango Development Studio only)
■ Meta Tags and Configuration Variables

■ Quick Reference card
■ on-line HTML help.

What You Need 
To Know

The following table shows the minimum and recommended 
configurations for Tango.

Component Minimum Recommended

Computer 68040-based Mac OS 
computer

Power PC-based Mac OS 
computer

Operating 
Environment

Editor
Mac OS 7.6.1

Server
Mac OS 7.6.1
Open Transport 1.1.2

Editor
Mac OS 8.1

Server
Mac OS 8.1
Open Transport 1.3

RAM Editor
5 MB free

Server
5 MB free

Editor
8 MB free

Server
12+ MB free

Web Server*

* Any server supporting the CGI standard should work with the CGI version of 
Tango. Only WebSTAR and ASIP are officially supported currently.

WebSTAR 1.3.2
or
AppleShare IP 5.0 Web 
Server

WebSTAR 3.0
or
AppleShare IP 5.0.2b Web 
Server

Oracle database 
access; see “Using 
Macintosh Oracle 
Libraries With 
Tango” on page 4.

Oracle database server 
and v2.1 of the Oracle 
client software

Same as minimum

FileMaker Pro FileMaker Pro 3.0v4 FileMaker Pro 4.0
3 3



Getting Ready to Install Tango
Before installing Tango, make sure the appropriate components are 
installed according to the system requirements. If you already have 
the necessary components installed, then you are ready to install 
Tango.

To get any late breaking 
news, you should visit 
the EveryWare Web site.

You should also look at the Read Me file on the CD-ROM. This file 
may contain information that was not available when this guide 
was printed.

Before installing Tango, you should do the following:

■ If you want to install the Web server plug-in, stop your Web 
server.

■ Close all open programs or applications. This reduces the 
chance of conflicts and frees system memory for the 
installation.

Using 
Macintosh 
Oracle 
Libraries With 
Tango

Tango 3 supports OCI connections with Oracle library version OCI 
7.1.4.1.5 or OCI 7.1.4.1.6 only. If you are using Intersolv’s 3.01 
Oracle ODBC driver, you require SQL*NET 2.1.4.0.4 and later (prior 
to 2.3). If you are using Intersolv’s 3.02 Oracle ODBC driver, you 
require SQL*NET 2.3.2.0.3.

You can tell which versions of OCI and SQL*NET you have 
installed by doing either of the following:

■ Run your Oracle installer and observe the version information 
that appears.

■ Open the “Oracle Libraries” alias in your Extensions folder, 
click OracleOci71Lib, and choose Get Info from the File 
menu.

If necessary, you can get OCI 7.1.4.1.5 from Oracle’s FTP site as part 
of the PO7 package. You can get OCI 7.1.4.1.6, SQL*NET 2.1.4.0.4, 
and SQL*NET 2.3.2.0.3 by getting in touch with Oracle client 
relations.

■ In the United States:
Gold Support 1 800 440-4653
Silver Support 1 800 223-1711
Bronze Support (407) 240-8900 (East)

(719) 635-8900 (Central)
(650) 506-1500 (West)

■ In Canada: 1 888 753-4428
■ Internet: http://support.oracle.com/

client_relations/
44



Installing Tango
Installing Tango

This section tells you how to install Tango. It covers the following 
topics:

■ what the Tango installer does
■ what you need to know
■ installing Tango.

What the 
Installer Does

The Tango installer does the following:

■ validates the product box number
■ accepts user input regarding components and configuration
■ checks for disk space
■ creates folders on your hard disk and copies Tango program 

files to them
■ installs Visigenic ODBC Manager or Intersolv ODBC Driver 

Pack
■ creates a Java folder below the folder where Tango Server is 

installed and copies Java files to it.

What You Need 
to Know

To install Tango you need to know the following information:

■ box number appearing on the product box
■ which Tango components you want to install and where on 

your hard disk you want to install them
■ your Web server folder
■ what mail server you want the Mail action to use.

Note You should close all applications on your computer, 
including your Web server, before continuing.
5 5



Installing Tango
Starting the 
Installation

1 Insert the Tango CD into your CD-ROM drive, and double click 
the Tango Install icon.

The Tango box number dialog box appears.

2 Type your box number and click OK.

The box number indicates which product you have purchased: 
Tango Development Studio or Tango Application Server.

Note The number is case sensitive, so you must type it exactly as 
it appears on the product box. If you get an error message telling 
you the box number is invalid, double check the number and try 
again. A common mistake is to confuse “1” (the number) with “l” 
(the letter) or “0” (the number) with “O” (the letter).

The Tango Installer splash screen appears.

3 Click Continue.

The EveryWare License Agreement appears.

4 Click Accept if you accept the terms of the agreement and to 
continue the installation.

The “Tango 3 Enterprise Release Notes” appear.

Before installing Tango, you should read these notes as they 
may contain information that is not included in this guide.

5 Click Continue.

Depending on which Tango product you have purchased, the 
Install window for either Tango Development Studio or Tango 
Application Server appears, for example:
66



Installing Tango
Note If you have purchased Tango Application Server, the Tango 
Editor and ODBC options do not appear in the Install windows.

6 From the install pop-up menu, select the type of installation 
you want to perform.

■ Easy Install installs everything you need to use either 
Tango Development Studio or Tango Application Server. If 
you are installing Tango for the first time, you should use 
this install method.

■ Custom Install allows you to individually select the Tango 
components to install, for example:
7 7



Installing Tango
Note To use the Tango Tutorials, you must install the Visigenic 
ODBC Manager. The Tutorials use the Butler SQL ODBC driver, 
and you cannot create new Butler SQL ODBC data sources with 
the Intersolv configuration manager.

To get more information on a particular option, click the 
information icon next to it.

When you select a custom option, Approximate disk space 
needed shows you the amount of disk space required to install 
that option. The amount of disk space available on the target 
disk appears beside Disk space available.

Before installing Tango, you should read the latest information 
about Tango that may not be included in this guide. If you have 
not already read this information, click Read Me... to view it 
now.

7 Tango Editor is installed in the Tango3 folder at the root of the 
specified disk. If you want to install Tango on a different disk, 
click Switch Disk to change disks.

Note You must select a locally mounted volume. The installer 
cannot install Tango on a network server volume.

8 Click Install.

A message appears recommending that you restart your 
computer after the installation and that if you continue the 
installer will automatically quit any applications you currently 
have running.

9 Click Continue.

If you are installing Tango Server, the folder selector appears.

If you are installing 
Tango Editor only, this 
folder selector does not 
appear.

Navigate to the folder you want to install Tango Server in, or 
click New Folder to create a new folder.
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Installing Tango
Note You must install Tango Server within your Web server root 
folder.

10 Click Select to continue.

The Mail settings window appears.

11 Type the name of the mail server and the default From address 
to use for the Tango Mail action.

If you leave the fields blank, you can use the config.taf 
application file to add this information later. For more 
information, see “Configuring Tango Server” on page 16.

12 Click OK.

The installer copies files to the locations you specified on your 
computer.
9 9



Installing Tango
If you are installing the Visigenic ODBC Manager, messages 
may appear telling you that newer files already exist. To use the 
Tango Tutorials, you must install the older files. Click Older in 
each case. You may also be asked if you want to move the ODBC 
2.x Bridge PPC file to the Trash. Click OK.

Tip After performing the Tutorials, you may go back to the newer 
version of ODBC by doing a Tango Custom installation of the 
Intersolv ODBC Driver Pack.

Once the installer finishes copying files to your computer, the 
following message appears.

See “Getting Your 
Registration Number” on 
page 11.

You must get a product registration number from EveryWare 
and register Tango before the five-day temporary license 
generated by the product expires. The five-day period starts 
when you first run Tango.

13 Click OK.

A message appears telling you the installation was successful.
1010



Installing Tango
14 Click Restart to restart your computer before using Tango 
(recommended), Quit to leave the installer, or Continue to 
perform other installations.

Getting Your 
Registration 
Number

To get your product registration number

1 Open your browser and go to the EveryWare registration Web 
site:

http://www.everyware.com/registration/

The EveryWare Product Registration form appears.
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2 Enter your product box number, and click Continue.

3 Fill in the rest of the form according to the on-screen 
instructions, then click Register.

EveryWare returns your registration number to you via e-mail 
within one business day.
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Registering Tango

When you first run Tango Editor, you are prompted to register it by 
entering your box and registration numbers. You must register 
Tango Editor before the five-day temporary license expires. You can 
also run Tango Server for five days before you must register it.

Note If you have purchased Tango Development Studio, which 
includes Tango Editor and Tango Personal Server, you must 
register it for both Tango Editor and Tango Server as described 
next.

Tango Editor To register Tango Editor

1 Open Tango Editor.

The Tango Editor Registration dialog box appears.

If you want to display 
the registration dialog 
box after Tango Editor 
has been registered, 
choose Enter New 
Registration Number 
from the Help menu.

2 Enter your box number and the product registration number 
you got from EveryWare.

3 Click OK to register Tango Editor.

If you click Later, Tango Editor runs under the temporary 
license for five days starting from when you first run it.

Tango Server To register Tango Server

1 Start Tango Server and execute the registration application file 
(Registration.taf) located in the :Tango3:Registration: 
folder under your Web server root folder, for example:

http://www.yourserver.com/Tango3/Registration/
Registration.taf

The Tango Server Registration form appears.
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2 Click Next.

The Tango Server Registration number entry form appears.

3 Enter the product registration number you got from 
EveryWare.

4 Click Next to register Tango Server.
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Starting and Stopping Tango Server

For more information, 
see “Registering Tango” 
on page 13.

If you have not already registered Tango Server, you should start 
Tango Server and register it before continuing.

If You Are 
Using the CGI

The Tango CGI is installed in your Web server root folder.

■ To start Tango Server, double click the Tango3.acgi icon.
■ To stop Tango Server, select Quit from the File menu.

You can also quit Tango Server using the keyboard shortcut, 
zQ.

If You Are 
Using the 
Tango Server 
Plug-in

The Tango Server plug-in is installed in your Web server Plug-Ins 
folder. The plug-in works only with Web servers supporting the 
WebSTAR API.

Note The plug-in is not available in a 68K version; to run Tango 
Server on a 68K machine, you must use the CGI.

■ To start Tango Server, double click your Web server icon.
■ To stop Tango Server, quit your Web server.

The Tango Server plug-in uses your Web server application’s 
memory. To ensure proper operation at your site, you should 
increase the memory allocated to the Web server.

To change the Web server application’s memory allocation:

1 If your Web server is already running, stop it before continuing.

2 Select the icon for the Web server application, and choose Get 
Info from the File menu.

3 Increase the Preferred size by at least 3000K (5000K is 
recommended).

4 Restart your Web server.
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Configuring Tango Server

The Tango Server preferences file, Tango 3 Server Preferences 
contains configuration settings for many Tango Server options. This 
file is located in the Tango3 folder in the Preferences folder. 
Configuration options are set by default. You generally do not need 
to edit the preferences file directly. 

You configure Tango Server by setting system configuration 
variables using the config.taf application file that comes with 
Tango. This file is located in the :Tango3:Config: folder in your 
Web server root folder.

To use it, execute the file in your browser, for example:

http://www.yourserver.com/Tango3/Config/config.taf

When you execute the config.taf application file, you are asked 
for a password.

The default password after installation is the first five characters of 
your box number. You can change the password by editing the 
value of the configuration variable, CONFIGPASSWD= in the Tango 3 
Server Preferences file. This change takes place when you 
restart Tango Server.

For detailed information 
on configuring Tango 
Server, see Chapter 20 in 
the User’s Guide, and the 
Meta Tags and 
Configuration Variables 
manual. You can also get 
configuration 
information by clicking 
the Tango Server button 
on the on-line HTML 
help button bar.

Note If you are editing the configuration file, you may see file 
stanzas for more than one server. This can occur because the same 
configuration file could be used by multiple servers. For example, 
one machine could be using Tango Personal Server (Development 
Studio) for development and a second remote machine could be 
using Tango Server for deployment. If you are editing the 
configuration file make sure you modify the correct file stanza, 
that is, [Tango_3_Personal_Server] or 
[Tango_3_Server].
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Click a category on the left to see the options for that category. Each 
option corresponds to a Tango configuration variable.

Caution The configuration options affect basic Tango Server 
functionality. Before changing any value, you should understand 
the effect of the change.

Configuration categories Corresponding Tango system 
configuration variables appear 
in text fields
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Converting Query Documents

Tango Editor can automatically convert Tango query documents 
from earlier versions to Tango application files. The file extension of 
query documents created in earlier versions of Tango is.qry.

The following describes how to convert your query documents and 
how the conversion alters query documents in creating an 
application file.

Note The data source names used in your 2.x documents are not 
retained. After conversion, the name of each data source will be 
the same as the database it connects to.

To convert query documents to application files

You can also drag a 
query document onto the 
Tango Editor icon on 
your desktop. Tango 
Editor automatically 
opens and starts the 
conversion process.

1 Open Tango Editor.

2 From the File menu, choose Open.

The Open dialog box appears.

3 Locate and select the query document you want to convert.

4 Click OK.

A message appears asking if you want Tango Editor to create 
an application file with the same functionality.

5 Click OK to continue, or click Cancel to cancel.

Note Converting a query document to an application file does 
not alter the original query document.

An application file window opens displaying the new application 
file with the same name as the query document and the Tango 
application file (.taf) extension.
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The conversion takes query document objects—actions, variable 
assignment attributes, meta tags, and global variables—and 
converts them to Tango 3.0 objects as follows:

■ All occurrences of “.qry” are changed to “.taf”.
■ Stop actions become Return actions.
■ Variable assignment—previously an attribute of an action—

becomes a separate Assign action.
■ Branch actions become If/Branch action pairs.

■ Assignments to doc$results become <@PURGERESULTS>; 
<@GLOBAL doc$results> become <@RESULTS>.

For more information on 
Tango 3.0 meta tags, see 
the Meta Tags and 
Configuration Variables 
manual.

■ The functionality of many previous meta tags has been 
enhanced. Tango takes care of the conversion to Tango 3.0 meta 
tags. The names of many of the previous meta tags have not 
changed, but the functionality of those meta tags has changed 
significantly.

Converting 
Text Files

If you have used the Tango 2.x <@INCLUDE> meta tag to include files 
containing Tango meta tags, use Tango Editor’s Convert Text File 
command to convert those files.

1 From the File menu, choose Convert Text File.

The Convert Text File selector appears.

2 Select the HTML or text file you want to convert.

3 Click Open.

The selected file is converted to the Tango 3 meta tag syntax 
and the original file is appended with (old).
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Using 
Converted 
Application 
Files

In general, converted application files should work as they did 
under Tango 2.x. However, some new features have made a few 
differences unavoidable. 

This section lists those differences and suggests application file 
changes to compensate for them.

Direct DBMS SQL Auto-Encoding

A new Tango Server feature automatically escapes single quotes in 
meta tag values substituted in Direct DBMS SQL. For example, if a 
variable called myName contains “O’Brien”, then

SELECT * FROM customer WHERE cust_name = ’<@VAR 
NAME=myName>’

now results in:

SELECT * FROM customer WHERE cust_name = ’O’’Brien’

In previous versions of Tango, the result was:

SELECT * FROM customer WHERE cust_name = ’O’Brien’

and a DBMS error resulted due to the unescaped quote.

In most cases, this new behavior does not adversely affect 
converted application files; however, there is one case in which it 
does. If your Direct DBMS SQL contains meta tags that evaluate to 
an entire (or partial) SQL statement constructed elsewhere, the 
quote-doubling may cause DBMS errors. This is because all single 
quotes are doubled, even those meant to delimit a string. In this 
case, the solution is to modify the meta tag(s) returning your SQL 
by adding the ENCODING=none attribute. For example:

<@VAR NAME=mySQL ENCODING=none>

Variable Scoping

Tango 3.0 supports various variable scopes. All global references in 
2.x query documents are converted to unscoped variable 
references. By default, assignments to non-existent unscoped 
variables cause a user scope variable to be created (equivalent to a 
2.x user global). When getting the value of an unscoped variable, 
Tango starts looking for the variable in local scope and moves on 
up to system scope until it is found.
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In short, variables in your converted documents will work as they 
always did. You should, however, consider modifying variable 
references in cases where other scopes (local, for example) are more 
appropriate. Doing so results in improved Tango Server 
performance and reduced memory requirements.

Assignments to System Configuration Variable

If you have query documents that assign to system configuration 
variables, you must make changes to the converted application file 
for them to work under Tango 3.0.

For information on how 
to change configuration 
variables, see 
“Configuring Tango 
Server” on page 16.

In Tango 3.0, a password is required to assign to system 
configuration variables (the old system globals). The password is 
specified by the CONFIGPASSWD= line in the Tango 3 Server 
Preferences file. The default value of this password is the first five 
characters of your Tango box number. When Tango Server 
encounters an assignment to a system configuration variable, it 
checks to see if there is a user scope variable called configPasswd 
whose value contains the same value as the one in the Tango 
preferences file. If so, the assignment is allowed; if not, an error 
occurs.

To make assignments to system configuration variables in 
converted documents work, make sure you add an assignment to 
user$configPasswd, which sets it to the correct value. Another 
(not secure and not recommended) option is to set the value of 
CONFIGPASSWD= in the Tango preferences file value to empty.
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Executing a Tango Application File

Using 
the Plug-in

Application files are executed in the same way HTML files are 
viewed—simply by specifying the name of the file in a URL, for 
example,

http://www.yourserver.com/shop/additem.taf

This example executes an application file called additem.taf 
located in the shop folder on the server, www.yourserver.com.

Using the CGI If you are using the Tango CGI instead of the plug-in, type the 
following in the URL line, replacing each italicized part with the 
actual information:

http://www.yourserver.com/tango3.acgi$/path to application 
file/yourfile.taf

Passing 
Parameters

You can pass parameters to the application file by using search 
arguments. These are name-value pairs appearing after a question 
mark in the URL, for example,

http://www.yourserver.com/shop/
additem.taf?item_num=8580

In this example, the item_num search argument has a value of 
“8580”.

See “Assigning Variables 
With the Assign Action” 
in Chapter 7 of the User’s 
Guide.

There are other ways of passing values to Tango application files. 
Form fields (post arguments) and cookies are two examples.
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Getting Help

Technical 
Support

In addition to the information available in the printed and online 
documentation, you can also get technical help with Tango.

Technical support requirements can differ among customers. For 
this reason, there are various support options available to meet 
your needs. Get in touch with your local distributor for more 
information about technical support contracts.

Tango-Talk Users are encouraged to join the Internet mailing list named 
Tango-Talk. The mailing list is the ideal place to discuss your ideas 
with other interested Tango users. It is also monitored by 
EveryWare technical support staff.

To join the Tango-Talk mailing list, go to:

http://www.everyware.com/customer_services/support/
dev_forum.htm

Other Inquiries You can get in touch with EveryWare by mail, telephone, or fax.

EveryWare Development Inc.
6733 Mississauga Road, 7th Floor
Mississauga, Ontario
Canada L5N 6J5

Telephone: (905) 819-1173
Toll Free: 1 888 819-2500
Fax: (905) 819-1172
Email: info@everyware.com

Web: http://www.everyware.com/
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